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Preface

Preface

This section describes the audience for, the organization of, and conventions used in this 
document.  It also identifies related documentation and explains how to access electronic
documentation. 

 Audience

This document is written for technical people who have basic understanding, familiarity 
and experience with network test and measurement equipment.  

 Conventions

This section describes the conventions used in this document.

Grayed-out Font
Indicates a command or a feature is not yet available in the current release.

Courier Font
Illustrates this is an example for a command or a concept.

Light Blue Font
Contains hyperlink to the referenced source that can be clicked on.

Normal Bold Font
When used within a sentence or a paragraph, it emphasizes an idea to be paid attention 
to particularly.

Red Font
Conveys special information of that section.

Note: This symbol means take note.  Notes contain helpful suggestions or references to 
additional information and material.

Caution:  This symbol means be careful.  In this situation, you might do something that 
could result in equipment damage or loss of data.

Warning: This symbol means danger.  You are in a situation that could cause bodily 
injury.  Before you work on any equipment, be aware of the hazards involved with 
electrical circuitry and be familiar with the standard practices for preventing accidents.
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Preface

 Obtaining the Latest Documentation and Software

Please visit the ThinkRF website at http://www.thinkrf.com/documentation/  to obtain 
the latest documentation.  Latest software and firmware releases are also available on 
ThinkRF website at http://www.thinkrf.com/download-updates/.

 Document Feedback

Please send your comments about this document or any ThinkRF documentation to 
support@thinkrf.com.

We appreciate your feedback. 

 Obtaining Technical Assistance

For all customers who hold a valid end-user license, ThinkRF provides technical 
assistance 9 AM to 5 PM Eastern Time, Monday to Friday.  Contact us at 
https://www.thinkrf.com/support/ or by calling +1.613.369.5104. 

Before contacting support, please have the following information available:

• ThinkRF product's model, serial number (S/N),  version (located on the 
identification label on the product's underside), and firmware version.   These 
information also available from the Device Info button in the the S240 RTSA 
application (see Viewing Device Information section).

• The S240 version (shown in the top bar of the GUI).

• Versions of any ThinkRF software you are using, including the API libraries to 
third-party applications.

• The operating system and version you are using.

ThinkRF S240 RTSA Software User Guide 5
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Overview of the S240 Real Time Spectrum Analysis Software

Overview of the S240 Real Time Spectrum 
Analysis Software

The S240 Real Time Spectrum Analysis (or S240 for short) software is a full-featured 
spectrum analysis application designed to work with all ThinkRF Real Time Spectrum 
Analyzers (RTSAs).  The S240 application provides standard spectrum analysis features 
including frequency controls, marker functions, and multi-trace capabilities.

The ThinkRF RTSA product is a high-performance software-defined RF receiver, digitizer
and analyzer.  With patent-pending software-defined RF receiver technology, the RTSA 
product provides industry leading combined sensitivity, tuning range, instantaneous 
bandwidth (IBW) and scan rate.  It has a hybrid RF receiver front-end (RFE) combining 
super-heterodyne, direct-conversion and direct digitization technologies with both wide-
band and narrow-band ADCs.  Additionally, it provides hardware-based triggering and 
capture control, thereby enabling sophisticated sweeping and real-time capture.  

The S240 software can measure signals such as Wi-Fi, Bluetooth, and LTE, and provides
markers that can be used to track specific frequencies.  Sophisticated FPGA-based 
frequency level trigger within ThinkRF RTSA products enables the capture of elusive, 
time-varying signals across an instantaneous bandwidth (IBW) of up to 100 MHz.  You 
can capture signal data, store it, and replay the captured signal at a later time.

The S240 application includes an intuitive graphical user interface that incorporates a full 
set of controls for fast and simple control of application features.  Fluid mouse navigation 
over the plot area allows you to quickly view the entire spectrum and easily zoom into 
areas of interest. 

The S240 application is built on the PyRF development framework, which is open-source 
under BSD licensing.  PyRF handles the low-level details of interfacing, real-time 
acquisition, signal processing and visualization, and provides feature-rich libraries, 
sample applications and source code, all specific to the requirements of signal analysis.  
For more information, visit the PyRF site at http://www.pyrf.org/.
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Overview of the S240 Real Time Spectrum Analysis Software

 S240 RTSA Graphical User Interface

The S240 RTSA Graphical User Interface (GUI) provides controls to manage the RFE 
mode of the RTSA product, trace capabilities, the frequency and amplitude display, along
with multiple plots such as spectrogram, persistence plot and time-domain raw IQ data, 
as well as measurement tools.

The main, central area of the S240 GUI contains the plot display, which shows the 
captured signal.  Current signal capture settings, including frequency span, amplitude, 
resolution and video bandwidths, and sweep speed are displayed below the plot.  Trace 
and marker information is shown above the plot.

Figure 1: An S240 Graphical User Interface Screenshot

Configuration controls for modifying S240 application settings are located on the left and 
right sides of the interface.  All configuration controls are shown by default, but you can 
hide them by opening the View menu and unchecking the Show/Hide Control Panels 
option.

The left-side panel contains frequently used settings for signal monitoring (amplitude, 
frequency and bandwidth).

ThinkRF S240 RTSA Software User Guide 7



Overview of the S240 Real Time Spectrum Analysis Software

The right-side panel contains control buttons that provide access to different configuration
functions.  The contents of each control button on this panel is either shown on the soft 
(middle) panel when selected or added as a plot to under the main plot.

Note: This section provides an overview of the S240 GUI.  Please refer to the
Configuring the S240 RTSA Application section for details on how to use individual 
settings and the options for each control.  

 Control Buttons and Soft Panels

The following table summarizes the control buttons available in the right-most panel of 
the S240 GUI, with a brief description of their function.

Control Button Function

Continuous Capture Enables continuous capture and display of signals 

Single Capture Enables a single capture and display of the signal 

Traces Displays parameters for configuring one or more traces on 
the signal display

Marker / Peaks Displays parameters for adding markers to signal trace(s) 
and configuring signal peak detection

Triggers Displays parameters to define the frequency level triggers for
signal capture (non-sweep modes only)

Spur Mitigation Displays parameters used to activate and adjust spur 
mitigation

Measurements Displays parameters for displaying different measurements 
on the plot display

Save Data Displays controls to capture and export signal data to a CSV 
file

Load Data Displays a control to load previously exported signal data

System Displays parameters to configure device control

Device Info Displays information about the RTSA device used to capture 
signals

Preset Displays a control to restore all configuration settings to 
default S240 start-up settings

Spectrogram Adds a spectrogram display of captured signals below the 
main plot display

Persistence Adds a persistence plot display of captured signals below the
main plot display

Time Domain Adds a time domain (I/Q) plot display of captured signal 
below the main plot display
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Getting Started with the S240 RTSA Software

Before installing the S240 RTSA software, ensure that your PC meets the following 
minimum system requirements:

• Operating System:
 Windows XP 
 Windows 7 (32-bit or 64-bit)
 Windows 10 (32-bit or 64-bit)

• RAM:  2 gigabytes (GB) 
• Hard Disk:  1 GB available

Note: You must have an Internet connection to download the S240 software from the 
ThinkRF website.

 Installing the S240 RTSA Software

You must download the S240 RTSA installer from the ThinkRF website to install the 
software on your computer.

1. Open a web browser, and go to http://www.thinkrf.com/download-updates/ Log-in
might be required.

2. Then under the Software Updates section, locate the S240 software and 
download the file.

3. When you have downloaded the zip file, extract the contents to a folder of your 
choice.

4. Double-click on the pyrf_RTSA_Installer_x.y.z.exe file to launch the Setup 
Wizard, and follow the prompts to select your installation options and install the 
software.

5. On the Ready to Install prompt screen, review your installation settings.  Click 
Install to proceed with the installation, or Back to change your settings.

6. When the Setup Wizard has completed software installation, click Finish to exit 
the Wizard.

 Connecting to a RTSA Device

You must connect to a RTSA product to view data in the S240 GUI application.  The 
application detects any RTSA devices that are on the same subnet of your network, but 
you must explicitly select one to complete the connection.
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Note:  Establish only one connection per RTSA device.  Accessing another device that is
in used would disconnect any existing capture process or change the settings of that 
device.

1. Launch the S240 GUI application from your computer's Start menu or desktop 
icon shortcut (if installed).  The application will display an Open Device window. 

2. Select a RTSA device from the list of “Devices Detected on Local Network”.  

If a RTSA device of interest is not on the list, you can either click the Refresh 
button to update the list or enter the IP address of the device manually in the 
Manually Enter Device IP field. 

3. Click Connect.

The S240 GUI application connects to the RTSA device and displays the user 
interface.  By default, the RTSA device acquires and measures signals 
automatically using the default S240 start-up settings.  

4. If you want to connect to a different RTSA product, click on the File menu and 
select Open Device.

The application will display the Open Device window.  Repeat steps 2 and 3 to 
connect to a new device.
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Configuring the S240 RTSA Application

The S240 RTSA application provides several options for controlling and displaying signal 
captured through the ThinkRF RTSA product.  You can set the RFE mode, specify the 
frequency span and amplitude, and add traces and markers to the signal display. 

 Configuring Signal Measurement

The S240 application can capture signals in swept-tuned mode or in real-time signal 
analysis mode.

You can choose between two sweep modes, and specify the frequency span for the 
sweep.  In real-time mode, you select the instantaneous bandwidth, and optionally, can 
set trigger parameters for signal capture. 

 Configuring the RFE Mode for Signal Capture

You can set the sweep type or instantaneous bandwidth for signal measurement in the 
Frequency Settings pane on the left side of the interface.

1. In the Instantaneous BW field, select the RFE mode for the application from the 
drop-down list:

Mode Description 

Sweep Normal Fastest sweep time (but lower amplitude accuracy) 

Sweep Accuracy Best amplitude accuracy (but slower sweep time)

40 MHz span 40 MHz instantaneous bandwidth (non-tunable)

100 MHz span 100 MHz instantaneous bandwidth (non-tunable).  Uses 
Zero IF (ZIF) signal path.  Note that the DC offset at the 
center frequency (always on) and the images that can be 
generated in this mode

10 MHz span 10 MHz instantaneous bandwidth (non-tunable)

100 kHz span 100 kHz instantaneous bandwidth (non-tunable).  Expands
the dynamic range of the spectrum analyzer to 100 dB; 
best for low-power signals

Baseband Fixed spectrum from 0 – 62.5 MHz (non-tunable)

2. For Sweep Normal or Sweep Accuracy mode, you can change the default 
frequency span of the signal to be monitored.  (For all other modes, the 
frequency span is determined by the value of the instantaneous bandwidth).

Do ONE of the following:

 Click on the slider bar beside the Center/Span label, then specify the central 
point of the frequency band you want to monitor in the Center field, and the 
frequency span in the Span field.  The span value is applied relative to the 
center frequency value.
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 Click on the slider bar beside the Start/Stop label, then specify the lower 
boundary of the sweep range in the Start field and the upper boundary of the
sweep range in the Stop field. 

 Optionally, specify the interval of frequency control field values by setting the 
Step field.

 Click the Full Span button to select the maximum available span (that is, the 
full tuning range, dependent on the model of the ThinkRF RTSA product).

3. For non-sweep modes, you can configure the way the application acquires and 
displays the captured signal.  

Do ONE of the following:

 Click on the Continuous Capture button in the right panel to enable 
continuous capture of signals.  The application acquires signals and displays 
them on a continuing basis.

 Click on the Single Capture button in the right panel to enable single capture
of signals.  The application acquires the signal once and displays it 
immediately. 

4. To change 10 MHz Reference source, select the External Reference Clock box 
to enable use of an external synchronization source for the PLL reference clock. 
Otherwise, an internal source is used.

 Configuring the Signal Amplitude Range

You set the amplitude range for signal monitoring using the parameters in the Amplitude
Settings pane on the left-side of the interface.

1. In the Reference Level field, specify a value for the maximum power level 
permitted for input signals.  

2. In the Scale/Div field, specify the distance between horizontal grid lines in the 
signal display (between 1 and 16 dB).

3. In the Reference Level Offset field, specify a value for the power offset for the 
signal display.

The offset is applied in software only and is reflected in the signal display 
including any recorded signals for playback.  The input signal itself is 
not affected.

4. Specify the attenuation/gain setting for the input signal by selecting one of 
the following:

 Auto Attenuation: enables automatic attenuation of the input signal, based 
on the maximum permitted power level (in the Reference Level field)

 Attenuation: enables or disables the device's attenuation of the incoming 
signal. 0 dB is equivalent to no attenuation.

 Gain Block: sets the gain level, which is available for the RTSA -418 or -427 
models only.  

 Configuring the Resolution Bandwidth

You can configure the resolution bandwidth to specify the smallest frequency that can be 
resolved as a separate peak on the display.  You can also configure the video bandwidth 
to reduce noise on the trace and make signals that would otherwise be obscured by 
noise easier to see on the display.
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You set the resolution bandwidth using the parameters in the Bandwidth Settings pane 
on the left-side of the interface.  

1. In the RBW field, specify a value for the resolution bandwidth.  This field is only 
enabled if the Auto option is not enabled.   

2. Optionally, select the Auto box to enable automatic calculation of the resolution 
bandwidth based on the frequency span.  The largest span yields the highest 
RBW, and the smallest span yields the lowest RBW. 

3. In the VBW field, specify the video bandwidth. 

4. In the VBW Filter field, select the type of filter to apply to the VBW bandwidth 
from the drop-down menu. 

 Configuring Triggers for Signal Capture (Non-Sweep Modes)

If signal acquisition is configured for a non-sweep mode, you can configure a trigger for 
signal capture.  In sweep mode, all trigger parameters are disabled.

1. Click the Triggers button to access the Triggering soft panel.

2. Select a Trigger type in the drop-down list.  Default to Free Run (no triggering).

3. If Level option is selected, the signal capture is based on specific conditions, 
defined by start and stop frequencies, and power level. 

• In the Trigger Start field, specify the minimum frequency required for signal 
capture.  When the system detects a signal above this frequency, the 
application begins signal capture. 

• In the Trigger Stop field, specify the maximum frequency for signal capture. 
When the measured signal exceeds this frequency, the application stops 
signal capture. 

• In the Trigger Level field, specify the minimum power level for signal 
capture.  The application only captures signals between the start/stop 
frequency range that are above this power level.

• The plot display shows a rectangle representing default trigger parameters: 
minimum frequency (left boundary), maximum frequency (right boundary), 
and power level (top boundary) as shown in 2.

• The level trigger parameters can be set by clicking and dragging the left, right
and top boundaries to change the minimum frequency, maximum frequency 
and power level respectively.

If the Level is too high, switching to other capture options might required toggling 
the Continuous or Single Capture button to get the capture going.

4. The Pulse trigger option is to be used with external synchronized pulse trigger 
setup, from which a pulse signal is provided to the RTSA's GPIO port to start the 
capture.  Hence, external hardware will be required for this trigger setup.  
Contact ThinkRF for more information.

If Pulse option is selected without the aforementioned setup, switching  to other 
capture options might required toggling the Continuous or Single Capture button 
to get the capture running.
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Figure 2: Level Trigger for Signal Capture

 Displaying Channel Power Measurement

You can display the channel power for a specific span in the frequency band, or of the 
section of the spectrum that occupies a specific proportion of channel power.

1. Click the Measurements button to access the Measurements soft panel.  

2. To view the channel power of a section of the signal on the display, click on 
Channel Power.

As shown in 3, the plot display shows two vertical lines to define the region of 
interest (default is 50% of the current spectrum), and the background color 
between the boundaries changes.

The measured channel power is displayed in the Measurements soft panel. 

3. Optionally, you can change the default region of interest by specifying values in 
the following fields: 

• Start Frequency: the lower boundary of the new frequency span

• Stop Frequency: the upper boundary of the new frequency span

4. To view the bandwidth occupied by a specific proportion of the channel power, 
click on Occupied Bandwidth. 

The plot display shows two vertical lines to define the region of interest (default is
99% of channel power) across the center of current spectrum, and the 
background color between the boundaries changes. 

The occupied bandwidth is displayed in the Measurements soft panel.
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5. Optionally, you can change the channel power percentage occupied by the 
monitored signal by specifying a value in the Occupied BW Power % field. 

Figure 3: Channel Power

 Enabling the Zero Span Plot

By default, the signal display area plots the frequency (in MHz) on the x-axis and the 
power level (in dBm) on the y-axis.  The Zero Span plot changes the x-axis to the time-
domain (in seconds), while the power level remains on the y-axis.  The spectrum plot 
updates continuously along the x-axis as each capture is received. 

Enabling zero span forces the S240 GUI to use the 10 MHz Span mode, which provides 
the most accurate amplitude level.

1. In the Frequency pane, click the Zero Span checkbox 

2. Optionally, specify a value in the Time Span field (if you do not want to use the 
default).

 Adding Markers and Traces to the Signal Display

The S240 GUI application supports up to six active traces on the plot display, and up to 
12 markers.

 Adding Traces

You can configure up to six active traces in the signal display.  By default, the first trace 
is set to display all values captured for the signal.  The following procedure applies 
to each trace.
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1. Click on the Traces button to access the Trace soft panel.

2. Select a trace by clicking on a number (from one to six) in the grid at the top 
of panel.

3. In the Trace Type field, select the display mode for the trace from the 
drop-down list:

Trace Type Description 

Clear/Write Trace plots all values captured for the signal.  Each new set
of data overwrites the previous set so that the trace is 
always up to date.

Max Hold Trace plots only the maximum values captured for the 
signal.

Min Hold Trace plots only the minimum values captured for the 
signal.

Average Plot the moving average of the captures set in Trace 
Average field.

4. Optionally, in the Trace Color field, select a different color for the trace from 
the palette.

5. In the View/Blank field, select the state of the trace from the drop-down list:

Trace Type Description 

Active The trace always remains active on the spectral plot.

View Hold the current trace in its current state.  This is equivalent
to Trace Hold.

Blank Turn the trace off.

6. Click the Clear Trace button to reset the trace display.     

7. Repeat steps 2 - 5 for each additional trace (to a maximum of six).

8. Click the Clear All Traces button to reset all traces on the display.

 Adding Markers

You can add up to 12 markers to the signal display and associate the markers with any 
trace on the display.  You can use delta markers to measure changes in power and 
frequency relative to a reference marker. 

You can set the position of the markers on the display to identify peaks in the captured 
signal.  When you activate peak search, the system turns on the first available marker 
and positions it at the highest peak on the signal.

1. Click on the Marker/Peaks button to access the Markers/Peaks soft panel. 

2. Select a number from the number grid (one to twelve) at the top of the 
configuration panel.  

3. In the Marker Frequency field, specify a frequency value to position the marker. 
You can also click and drag the marker to the desired position on the display. 
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The Marker Power field shows the power level of the marker in real-time, and is 
read-only.

4. In the Marker Mode field, select a mode from the drop-down list:list:

Mode Description 

Normal The marker's amplitude position changes with the amplitude of
the signal (but the frequency position remains the same).

Fixed The marker stays at the same frequency and amplitude 
(power level), regardless of changes in the amplitude of the 
signal.

Off The marker is removed from the display. 

Delta <n> If there is at least one primary marker on the display, the 
marker is set as a delta marker relative to the specified 
primary marker.  For example, if there are two primary 
markers on the signal display, you can designate Marker 3 as 
Delta 1 or Delta 2. 

The delta marker appears on the signal display (as an inverted
triangle icon) with the number corresponding to the tab 
hovering above it.  The frequency and power values of the 
delta marker appear on the display above the grid.

5. In the Marker Trace field, assign the marker to a trace by selecting the trace 
from the drop-down list.  The list contains all active traces on the display. 

6. Optionally, you can configure the position of the marker on the display to indicate
peaks in the captured signal by clicking on one of the following buttons:

 Peak Search: positions the marker at the highest peak signal. 

 Next Peak: positions the marker at the next highest peak signal, wherever it 
occurs.

 Next Peak Left: positions the marker at the highest peak signal to the left of 
the current marker position.

 Next Peak Right: positions the marker at the highest peak signal to the right 
of the current marker position.

 Marker -> Center: changes the center frequency to match the current 
(primary) marker position.  

7. Select the Continuous Peak box to allow the marker to move to the highest 
peak as it occurs on the display.

8. Select the Pk Threshold box to define a threshold for peak detection, and 
specify the minimum power level for a marker position.  Markers are not applied 
to peaks that fall below this power level.

9. Repeat steps 2 to 8 for each additional marker (to a maximum of 12).

10. Optionally, select the Marker Table On box to display a list of all active markers 
(with their corresponding mode, frequency, power level, and trace assignments) 
below the plot display. 

You can click on an entry in the Marker Table to select it on the plot display.  
The values in the table show measurement fluctuations in real-time.
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11. Optionally, you can save the information about current markers (i.e., their power 
level and frequency position) in a .csv file.  Click Save Marker Table and specify 
a file name and location in the CSV File dialog. 

12. To remove a single marker, change the Marker Mode field to Off. 

13. To remove all markers from the display, click All Markers Off.

 Customizing the Plot Display

You can add horizontal and vertical lines to the plot display of the monitored signal to 
highlight a specific section of the signal power level.  You can also use your mouse to 
zoom in or out of the plot display, and change the area displayed. 

 Adding Lines to the Display

1. To add a horizontal line, click the H1 button at the top of the plot display.

2. To add a second horizontal line, click the H2 button. 

3. To add a vertical line, click the V1 button.

4. To add a second vertical line, click the V2 button. 

5. To add a cross-hair cursor to the center of the signal display (i.e., at the center of
the amplitude range and frequency span), click the Cross Hair button ( ). 

You can also change the position of the horizontal and vertical lines by clicking and 
dragging them on the plot display.

 Configuring DSP Correction Options

The S240 RTSA application provides mechanisms to correct the effects of input-related 
spurs.

 Enabling Spur Mitigation

Spur mitigation reduces the level of input-related spurs.  The algorithm works by 
identifying the spur level, and suppressing it using the spur mitigation control.

1. Click on the Spur Mitigation button to access the Spur Mitigation panel. 

2. Select the Spur Mitigation box to enable spur mitigation.

3. In the Spur Level field, enter a power level value to target a specific spur.

4. In the Spur Bandwidth field, enter a frequency value to target a specific spur. 

 Configuring  Device Control Options

You can configure device control settings to ensure signal information is captured and 
displayed in a manner appropriate to your application.

1. Click the System button to access the System Settings soft panel. 
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2. In the Decimation field, select a value from the drop-down list to set the 
decimation rate for the signal (enabled for non-sweep modes only).

3. In the Fine Tune field, set the value of the frequency shift.  A negative value 
corresponds to a left shift (enabled for non-sweep modes only).

4. In the IQ Path field, specify the IQ output path from the drop-down list 
(Digitizer or Analog). 

Note: If you select the “Analog” option for IQ Path, you are using the device in Down-
Converter mode and bypassing all internal digitizing functions.  The signal display area 
disappears from the interface when you select this option.

 Restoring System Defaults

You can return reset all parameter values to system defaults.  If you want to save your 
custom settings before restoring the system defaults, see the Administration section.

1. Click on the Preset button to access the Preset soft panel.

2. Click the Preset All button to restore all settings to factory default values.  
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Viewing Signal Data

You can view captured signal data in several modes.  The S240 GUI application supports
the following displays:

• Spectrogram 

• Persistence plot 

• Time Domain plot

 Displaying the Spectrogram Plot

The spectrogram plot displays spectrum changes over time in a three-dimensional view.  
Time is displayed on the vertical axis, and frequency on the horizontal axis.  The 
amplitude of the frequency components is expressed by color.  

Figure 4: Spectrogram Plot

1. Click on the Spectrogram button.  The spectrogram plot appears below the main
signal waveform display.  

2. You can enhance the signal display by sliding the triangles on the color palette 
(left side of the display) to adjust the threshold at which the signal changes color. 
This allows you to specify colors for each noise floor level.

3. To hide the Spectrogram plot, click on the Spectrogram button again. 
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 Displaying the Persistence Plot

The persistence plot is a view of how long a signal remains present; as the signal grows 
weaker, the trace fades in color.  Amplitude is displayed on the vertical axis, and 
frequency on the horizontal axis.

Figure 5: Persistence Plot

1. Click on the Persistence button.

The persistence plot appears below the main signal waveform display.  

2. You can enhance the signal display by sliding the triangles on the color palette 
(left side of the display) to adjust the threshold at which the signal changes color. 
This allows you to specify the colors used to represent the shades of persistence 
of the spectrum.

3. To hide the Persistence plot, click on the Persistence button again. 

 Displaying Time Domain Plots

A Time Domain plot of captured signal information is particularly useful when using the 
device in IQIN mode.  The Time Domain view includes two plots:

• Constellation plot (left side) shows the in-phase (I data) vs quadrature 
(Q data) plot 

• Time domain plot (right side): shows a trace for the In-phase (I data in green) and 
a trace for the quadrature (Q data in red, if available in the mode)
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Figure 6: Time Domain Plots 

1. Click on the Time Domain button.

The Time Domain plots appear below the main signal waveform display.  

2. To hide the Time Domain plots, click on the Time Domain button again. 
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Capturing Data from the S240 RTSA Application

In addition to viewing signal data in real time on the S240 application, you can also 
capture and store signal information for playback, or for further processing by another 
application.

Caution:  The S240 RTSA application does not impose a limit on the file size for signal 
recording or writing to a CSV file.  If recording is not explicitly stopped, the application 
continues to write data to the file until the local hard drive is full. 

 Capturing a Screenshot

The S240 RTSA application allows you to capture a screenshot of the current application 
window.  The screenshot is stored in a PNG file format.

1. Open the View menu and select the Dashboard Screenshot option.

2. In the PNG File window, specify a file name and storage location for the 
screenshot. 

3. Click Save to save the image. 

 Saving Signal Data

The S240 RTSA application allows you to capture and export signal data to a CSV file for
playback or further processing by another application.  All recorded data is stored on the 
PC that is hosting the S240 RTSA application. 

By default, the system stores the file (csv-0000.csv) in the pyrf/RTSA/Scripts/dist 
directory.

1. Click the Save Data button to access the Save Data soft panel. 

2. Optionally, enter a comment in the Comments box.  The text you enter is added 
to the top of the saved .csv file. 

3. To use the default file name and storage location, click on Save Data.

The RTSA application begins saving signal data to the CSV file.

4. If you do not want to use the default location for your saved data, click on the 
destination directory icon ( ) and specify a path in the Select Directory window.

5. If you do not want to use the default name for the CSV file, click on Save Data 
As and specify a file name in the CSV File window, then click Save. 

The RTSA application begins writing the signal data to the CSV file.

6. To stop saving signal data to the CSV file, click Stop Saving. 

The RTSA application stops writing the signal data to the CSV file.
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The stored CSV file contains the following information about the captured signal:

Parameter Description 

mode The RFE mode of the device during signal capture.  Possible 
values are:

ZIF (100 MHz instantaneous bandwidth)
SH (40 MHz instantaneous bandwidth)
SHN (10 MHz instantaneous bandwidth
HDR (100 kHz instantaneous bandwidth)
DD (Baseband, 0-50 MHz instantaneous bandwidth; no tuning)

fstart The start of the frequency range (Hz)

fstop The end of the frequency range (Hz)

size Number of data points (power values) captured for the signal in
the CSV file

timestamp ISO time-stamp representing time at which the data was 
displayed in the S240 GUI

<data> A series of integers representing the power value of the 
captured signal for each sample.  The number of data samples
corresponds to the value specified in the size parameter. 

geolocation For the R5700 product only, Latitude (decimal degree) | 
Longitude (decimal degree) | Altitude (meter) | Speed (meter 
per second) | Track (degree)

 Playing Back a Recorded Signal

The S240 RTSA application allows you to play back a previously recorded signal.  
The .csv file containing the signal data must be located on the PC that is hosting the 
RTSA application.

1. Click the Load Data button to access the Load Data soft panel. 

2. Click Load Data.

The application opens an Explorer window, defaulting to the location of the last 
saved CSV file. 

3. Select the .csv file you want to play, and click Open. 

The RTSA application loads the signal data and plays back the recorded signal 
continuously, in loopback mode.  Use Continuous or Single Capture to control 
the playback.  Measurements could be applied to the playback data as well.

Note: You can add traces and markers to the signal playback display.  Frequency and 
device controls are disabled. 

4. To stop playback of the recorded file, you must do one of the following:

 open a different file for playback (repeat step 1) 

 reconnect to the device (using the File > Open Device option) 
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 exit the S240 RTSA application 
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Administration

In addition to signal capture functionality, the S240 application provides additional 
features that allow you to save and store one or more configuration profiles and to 
customize the configuration panel display.

 Saving Configuration Settings

The S240 RTSA application allows you to save current configuration settings in a file that 
you can reload at a later date.  All saved settings files are stored on the PC that is hosting
the S240 RTSA application.

You can view the contents of the *.config file in a text editor.

1. To save the existing S240 RTSA application settings, open the File menu and 
select the Save Settings option.

The RTSA application opens an Explorer window.

2. In the Configuration File window, specify the name and path for the 
configuration file.

3. Click Save.

The S240 RTSA application saves the current configuration settings file 
(with .config extension) in the specified location.  

 Loading Configuration Settings

You can load S240 RTSA application configuration settings from a saved configuration 
file.  The file must exist on the PC  that is hosting the S240 RTSA application.

1. Open the File menu and select the Load Settings option.

The application opens an Explorer window, defaulting to the last location used to 
save configuration settings or signal information.  (You can navigate to another 
folder using the Explorer window).

2. Select the .config file you want to load, and click Open.

The S240 application loads the configuration settings from the file and updates 
the application accordingly.   

 Viewing Device Information

You can display information specific to the RTSA device you are using to capture signals.

The IP address of the RTSA device you are connected to is displayed in the title bar of 
the window, as well as the software version of the S240 application.
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1. Click on Device Info to access the Device Info soft panel.  This soft panel 
displays the following information of the RTSA device currently connected to:

• Model:  the TRSA product model number

• Serial Number:  the serial number of the RTSA hardware

• Product Version:  the RTSA hardware version

• Firmware Version:  the currently running firmware version

For the R5700 product with GNSS, the soft panel displays he following position 
information

• Latitude: degrees, minutes, and seconds

• Longitude: degrees, minutes, and seconds

• Altitude: meters (m)

• Speed: meter per second (m/s)

• Track: the direction of traveling in degrees

 Accessing Product Documentation

You can access this PDF document from the S240 GUI's Help menu.  For Windows 
users, you must have Adobe Reader installed on the machine to view the documents.  
For Linux users, the document will be opened through your default web browser.
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